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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “ XXXXX" is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP4725 PICtail™ Plus Daughter Board. Items discussed in this chapter include:

* Document Layout

» Conventions Used in this Guide

* Recommended Reading

e The Microchip Web Site

e Customer Support

« Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP4725 PICtail™ Plus Daughter Board as
a development tool to emulate and debug firmware on a target board. The manual lay-
out is as follows:

e Chapter 1. “Quick Start Instructions” — this chapter provides an overview of the
MCP4725 PICtail™ Plus Daughter Board and instructions on how to program the
DAC register and EEPROM of the MCP4725 device.

* Appendix A. “Schematics and Board Layouts” — shows the schematic and lay-
out diagrams for the MCP4725 PICtail™ Plus Daughter Board.

« Appendix B. “Bill Of Materials (BOM)” — lists the parts used to build the
MCP4725 PICtail™ Plus Daughter Board.

© 2008 Microchip Technology Inc. DS51722A-page 1
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, R is the radix and n is a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl1l8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OXFF, “A”

Italic Courier New

A variable argument

file.o, where File can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file
[options]

Curly brackets and pipe
character: { |}

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var_name [,
var_name...]

Represents code supplied by
user

void main (void)
{ ...
}

DS51722A-page 2
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RECOMMENDED READING

This user's guide describes how to use MCP4725 PICtail™ Plus Daughter Board. The
following Microchip documents are available and recommended as supplemental
reference resources.

PICkit™ Serial Analyzer User’s Guide (DS51647)

Consult this document for instructions on how to use the PICkit Serial Analyzer hard-
ware and software.

MCP4725 Data Sheet, “12-Bit DAC with EEPROM Memory in SOT-23-6"
(DS22039)

This data sheet provides detailed information regarding the MCP4725 product family.
MCP4725 SOT-23 Evaluation Board User’s Guide (DS51669)

PIC24FJ128GA010 Family Data Sheet (DS39747)

Explore 16 Development Board User’s Guide (DS51589)

AN1079, “Using the C3 Compiler and the I12C Peripheral to Interface Serial
EEPROMSs with dsPIC33F" (DS01079)

PICkit™ Serial Analyze User’s Guide (DS51647)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

« Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

* General Technical Support — Frequently Asked Questions (FAQSs), technical
support requests, online discussion groups, Microchip consultant program
member listing

* Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

* Local Sales Office

* Field Application Engineer (FAE)

 Technical Support

Customers should contact their distributor, representative or field application engineer

(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

© 2008 Microchip Technology Inc. DS51722A-page 3
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DOCUMENT REVISION HISTORY
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Chapter 1. Quick Start Instructions

1.1 INTRODUCTION

The following sections provide an overview of the MCP4725 PICtail™ Plus Daughter

Board and demonstrate how to use (a) the MCP4725 device in a 16-bit MCU environ-

ment and (b) evaluate the MCP4725 device features using the PICkit™ Serial Analyzer

(P/N: DV164122). The MCP4725 PICtail™ Plus Daughter Board is designed to work

with both the Explorer 16 Development Board (P/N: DV164033) and the PICkit" Serial

Analyzer (P/N: DV164122).

The following topics are covered:

 Description of the MCP4725 PICtail™ Plus Daughter Board

« How to use the MCP4725 PICtail™ Plus Daughter Board with the Explorer 16
Starter Kit

« How to use MCP4725 PICtail™ Plus Daughter Board with the PICkit" Serial
Analyzer

1.2 DESCRIPTION OF THE MCP4725 PICtail™ Plus DAUGHTER BOARD

The MCP4725 PICtail™ Plus Daughter Board (P/N MCP4725DM-PTPLS) contains an
MCP4725 12-bit Digital-to-Analog Converter (DAC). This daughter board has the fol-
lowing two interfaces:
» Explorer 16 Starter Kit (P/N: DV164033) for 16-bit MCU environment
* PICkit™ Serial Analyzer (P/N: DV164122) for reading and writing the DAC

register and observing the DAC output
The user can connect this daughter board to one of the above tools and perform their
own experiments.

The board has test points for SDL, SDA, and Vot By connecting an oscilloscope to
these test points (to SCL, SDA, Vqy7) or Digital Multimeter to Vo, the user can exam-
ine the data communications through the 1°C™ bus line and observe the resulting DAC
output (VgouT)- Refer to Appendix A. “Schematic and Layouts”

1.2.1 I2C Address Bits and A0 Address Bit Selection

The I12C device code and address bits of the MCP4725 device are:

* Device Code: “1100~

e A2, Al, AO Address Bits: “00X~”, where X is for the AO bit which is determined by
the logic state of the AO pin

Note that the first two address bits (A2 and Al) are programmed at factory during
device production and AO bit is programmed by the user during applications. The A2
and Al address bits of the MCP4725 device used for the MCP4725 PICtail™ Plus
Daughter Board are programmed at the factory to “00”. The JMP1 connector on the
MCP4725 PICtail™ Plus Daughter Board selects the A0 bit. The following conditions
show the AO bit selection:

* AO bit= “1~ if IMP1 is connected to Vpp

* AO bit = “0~ if IMP1 is connected to Vgg (Default setting)

* Address bits A2, A1 = 00~

© 2008 Microchip Technology Inc. DS51722A-page 5
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Based on the above information, the combined device code and address bits for the
12C Serial Communication are:

« 1100-001W/R: if IMP1 is connected to Vpp

+ 1100-000W/R: if JMP1 is connected to Vss

« Where W/R is write(“0”) or read (“17) bit.

S F ¥ 3R

SDAW, VSS sSChy vss (Vout

* MICRCCHIP

- -.___-"'""-..

oot
NCP4725
P BicTail Plus
142 Daughter Board

ATG | I
s R4. :::=2 ’TC‘L... JP4

FIGURE 1-1: Front and Back Views of the MCP4725 PICtail™ Plus Daughter
Board.

1.3 GETTING STARTED WITH EXPLORER 16 DEVELOPMENT BOARD

Figure 1-2 shows the MCP4725 PICtail™ Plus Daughter Board with the Explorer 16
Development Board. When they are connected, the user can program the 16-bit
PIC24FJ128 MCU on the Explorer 16 Starter Kit. The Explorer 16 Development Board
sends I°C serial communication commands to the MCP4725 PICtail™ Plus Daughter
Board for the MCP4725 DAC output. The Explorer 16 MCU firmware for this MCP4725
PICtail™ Plus Daughter Board writes to the DAC input register continuously in 1 LSB
increments. The user can see the DAC output (VgyT) changes using an oscilloscope.
Also, a buzzer on the MCP4725 PICtail™ Plus Daughter Board makes sounds driven
by the DAC OUtpUt (VOUT)'

DS51722A-page 6 © 2008 Microchip Technology Inc.
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131 Connecting to the Explorer 16 Starter Kit

1. Connect the MCP4725 PICtail™ Plus Daughter Board to the J5 socket on the
Explorer 16 Development Board as shown in Figure 1-2.

MCP4725

1 __PICtail Plus
Daughter
Board

Explorer 16 Development Board (P/N DV164033)

FIGURE 1-2: Connecting the MCP4725 PICtail™ Plus Daughter Board to the
Explorer 16 Development Board.

1.3.2 Programming the PIC24FJ128 MCU

The Explorer 16 Development Board contains the PIC24FJ128 MCU. The user can
download the firmware to the MCU using the MPLAB ICD2 programmer. Refer to
Chapter 2 of the Explorer 16 Development Board User’s Guide (DS51589) for details
on the programming of the Explorer 16 Development Board.

1.3.2.1 THE PIC24FJ128 MCU FIRMWARE FOR THE MCP4725 PICtail™ Plus
DAUGHTER BOARD

The original firmware for the Explorer 16 Development Board is modified for the
MCP4725 PICtail™ Plus Daughter Board demonstration. The firmware uses most of
the original codes for the Explorer 16 Development Board except the 1°C peripheral
control routines for the PIC24FJ128 MCU.

The following four routines are added or modified from the original Explorer 16 Devel-
opment Board firmware.

* PIC24ExplDemo_MCP4725 Main.c

* MCP4725_i2C_Func.c

e Banner_MCP4725.c

* i2C_MCP4725.h

The user can modify the above routines for their own application.

The source code is compiled by using Microchip’s C30 Compiler and the hex code is
programmed to the MCU using the MPLAB ICD 2. Figure 1-3 shows connection of the
MPLAB ICD 2 and the Explorer 16 Development Board. Figure 1-4 shows the MPLAB
IDE programming environment.

© 2008 Microchip Technology Inc. DS51722A-page 7
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1.3.2.2 FIRMWARE FLOW CHART FOR THE MCP4725 DAUGHTER BOARD

Figure 1-5 shows the flow chart of the firmware. Once the MCU firmware is pro-
grammed, the user can observe the following events:

1. Voyrtchanges as the MCU rewrites the DAC codes. See Figure 1-6 for the Vout
waveform.

2. Audible sounds (Buzzer) if JP4 is connected.

3. 1°C data communication (SDA and SCL) waveform over the 1°C bus line. See
Figure 1-6 and Figure 1-7.

1.33  DAC Output (Vour)

The MCU sends write commands for EEPROM and DAC input register.

The MCU writes EEPROM only once, but writes continuously the DAC input register.
The EEPROM is written for the Vot = Vpp/2, and the DAC input register is continu-
ously written for the Vg1 to be ramp: The DAC input code is written from “000h” to
“FFFh” with 1 LSB increment. When it reaches “FFFh”, resets to “000h” and repeats the
writing from “000h” to “FFFh” with 1 LSB again.

The user can observe the Vo at the Vo7 test pin using a digital voltmeter or
oscilloscope. Figure 1-7 shows the 12C clock (SCL) and data (SDA) signals, and DAC
output waveform.

The DAC input register is written with fast mode write command which does not affect
the EEPROM. The user can confirm the data written in EEPROM (Vgqy1 = Vpp/2) by
disconnecting the MCP4725 PICtail™ Plus Daughter Board from the Explorer 16
Development Board. When the board is first powered, the MCP4725 device loads the
EEPROM data to the DAC input register by itself and then outputs an analog voltage
determined by the EEPROM data.

1.34 Audible Buzzer

The MCP4725 PICtail™ Plus Daughter Board includes a buzzer. This buzzer is directly
connected to the Vo1 The user can disable the buzzer by disconnecting JP4. The
buzzer sounds also can be adjusted by VR1.

DS51722A-page 8
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e ————— 1
sssesoseol ——
= SSRRRRERER -

—

CROCHIP

Explorer 16 Development Board MCP4725 PICtail Plus
(P/N DV164033) Daughter Board
(P/N MCP4725DM-PTPLS)

FIGURE 1-3: MPLAB ICD2 connection to Explorer 16 Development Board with the MCP4725
PICtail™ Plus Daughter Board for programming.
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P~ START

SEND I°C WRITE COMMAND

TO WRITE EEPROM DATA FOR
Vout = Vpp/2

'

TURN ON LEDS (D4, D6, D8, D10)

>¢

DATA =0
¢<

SEND I>°C WRITE COMMAND FOR DAC INPUT REGISTER

DAC INPUT REGISTER DATA = DATA + 1 LSB

(VOUT = RAMP FROM 0V TO VDD)

YES

DAC INPUT DATA == 4096 LSB ? NO

FIGURE 1-5: Flow Chart for the MCP4725 PICtail™ Plus Daughter Board Firmware.
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1°C
Clock Signal
(SCL)
1°C
Data Signal
(SDA)
(a) Write DAC Input Register and EEPROM
(DAC Code = 1000-0000-0000)
\% Dn
Expected DAC Output = ~22° 11 — 5 ¢800(hex) _ , 5,
4096 4096
Clock Signal r' rrr' !-|-IF rrr' rrrrrrrrrrrrrr'
(SCL) ---.‘-‘--.-“.ii!l#‘.iiﬂﬂl..‘!‘l'l-
I
uBnslalll
1’C | I
Data Signal
(SDA)
(b) Fast Write Command
(DAC Code = 0110-1101-1001)
\Y Dn
Expected DAC Output = ~22 =11 — 5 ¢6DI(hex) _ , 1395y
4096 4096
FIGURE 1-6: 12C Write Command Waveforms for the MCP4725.
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1°C
Clock Signal
(SCL)

1°C
Data Signal
(SDA)

Vour
at VOUT Pin

Write Data (Dn) = 1111 - 01101111 (binary)
Vv Vpp ¢Dn
OUT = 4096

= 4823V for VDD =5V

FIGURE 1-7: I2C SCL, SDA, and Vg1 Waveforms while incrementing the DAC code by 1 LSB.
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14 GETTING STARTED WITH PICKIT™ SERIAL ANALYZER
The user can use the MCP4725 PICtail™ Plus Daughter Board with the PICkit™ Serial
Analyzer by setting up as shown in Figure 1-8.
The following describes how to use them together:

1. Connect the MCP4725 PICtail™ Plus Daughter Board’s J2 pin socket to the
PICKkit™ Serial Analyzer.

2. Connect a Digital Voltmeter to Vgy7 pin and Vgs.

MCP4725 PICtail Plus Daughter Board

PICKit Serial Analyzer Analog Output Voltage (Vout)
Connected to Voltmeter

USB Cable: Connected between the PICkit Serial analyzer and Personal Computer.

FIGURE 1-8: MCP4725 PICtail™ Plus Daughter Board with the PICkit™ Serial Analyzer.

DS51722A-page 14 © 2008 Microchip Technology Inc.
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141 PICkit™ Serial Analyzer PC Software Set-Up for the MCP4725
Daughter Board

The following steps describe how to set and use the PICkit™ Serial Analyzer PC
Graphic User Interface (GUI) to control the MCP4725 PICtail™ Plus Daughter Board.
1. Install the PICkit™ Serial Analyzer software onto your personal computer (PC).
2. Connect the USB cable between the PICkit™ Serial Analyzer and your PC.

3. Runthe PICkit™ Serial PC Software: It will open up to the following graphic user
interface (GUI). Click the Next button and follow the instructions:

Configuration Wizard E

Welcome To The
PICkit Serial Analyzer
= Configuration Wizard

-_’: The following steps will guide you through the

o zetup of the PICK Senal Analyzer.

| Mext = | Cancel

4. Select the Communication Mode type: 12C Master, and click the Next button.

Configuration Wizard H

Communication Mode - Page 1 of 4

Chooze which mode of communication you wizh to uze.

)

12C M aster

SPI M aster

USART Async
USART Sync baster

R

< Back Mest > Cancel

© 2008 Microchip Technology Inc. DS51722A-page 15
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5. Select 100 kHz or 400 kHz. Either one will be fine. Click the Next button.

Configuration Wizard E

Communication Speed - Page 2 of 4
Select your [2C communication zpeed

Communication speed may alzo be
I 100kHz  adjusted by using the 'Configure
¥ 400 kHz hMode' page from the 'PICkIt Serial
Analyzer menu dropdowen after
completing the Configuration
Wfizard.

¢ Back Memt > Cancel

Note: The MCP4725 device supports the 12C bus data rate up to 3.4 MHz, but the
current version of the PICkit™ Serial Analyzer supports the 12C bus data
rate up to 400 kHz only.

6. Select No on Enable Pull-ups, and click the Next button.

Note: The MCP4725 PICtail™ Plus Daughter Board has its own pull-up resistors,
therefore, you don’t need additional pull-up resistors from the PICkit™
Serial Analyzer.

Configuration Wizard E

Device Pullups - Page 3 of 4

Do vou need to enable pullupz for your device?

Enable Pullupz
" Yez ™ Mo

¢ Back Mext » Cancel
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7. Selectthe Vpp voltage of the MCP4725 PICtail™ Plus Daughter Board and click
the_Next button.

Case 1: When you use Vpp from the PICkit™ Serial Analyzer:

If you choose PICKit™ Serial will power my device and 5 Volts as shown
below, the the MCP4725 PICtail™ Plus Daughter Board is powered by the

5V DC from the PICkit™ Serial Analyer through the JP1 jumper. In this case,
make sure that the JP1 jumper on the MCP4725 PICtail™ Plus Daughter Board
is connected.

Case 2: When you use your own Vpp:

You can also provide your own Vpp voltage by applying a Vpp voltage at TP1. In
this case, make sure that the JP1 jumper is disconnected.

Configuration Wizard E

Yoltage Source - Page 4 of 4
Does PICKR Senial need to power your device?

Yoltage

v FICkit Serial wil

power my device . o
IF PICKit Serial will poweer wour

f# 5%l device, select the checkbox to
™ Other the left, then determine pour
voltage.

g0

¢ Back Memt > Cancel
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8. Click the OK button. You have made all of the PICkit™ Serial Analyzer Configu-
ration Set-ups. You are now ready to program the MCP4725 PICtail™ Plus
Daughter Board using the PICkit™ Serial Analyzer.

Configuration Wizard E

You're Done!

Prezz '0FK' ta complete the Configuration ‘wizard.

RIFER

[ Do not show this wizard on startup again

“Wwizard may be accessed anytime Fram
menu dropdown PICKE Senal Analpzer -»
Fun Confiquration wizard.

Ok

DS51722A-page 18 © 2008 Microchip Technology Inc.
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1.4.2 Creating Script Files

In order to make a communication between the PICkit™ Serial Analyzer and the
MCP4725 PICtail™ Plus Daughter Board, it needs a script file. The following procedure
shows how to create script files and how to use them.

1. Select Communication ----- > Script ---> Script Builder.

Ckit Serial - 12C Master Mode

Cammunications | PICKE Serial Analyzer  DemaBoards  Lser Defined Templates  View  Window  Help

Basic Operations sic Operations | Reset l2LM

Sarpt Srip Buider I stos

- [ Update
Seript Execute I Executive Emar

W Communicztion Eror
I I2€ Eror

1 | j
Transactions EitRate: 100.0kHz

Source Waltage: 4.4
[rata Line Waltage: 484
Clock Line oltage: 4.7

File » Edit v Clear

02/13/2007 4:59:14 PH

Welcome to PICkit Serial version 2.0.1.0

Found PICkits.d11 - Ver: 1,3.0.0

Found PICkit Serial Analyzer - FW Ver: 0x0108
1158 cantral block updated with preference data.

Basic WView Set,

© 2008 Microchip Technology Inc. DS51722A-page 19
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1421 CREATING SCRIPT FILES TO PROGRAM DAC REGISTER

1. Click on WriteBlockAddrA8 in “Example 12C Scripts” column.
This will fill in the spaces under Script Detail column.
Modifying the Script Details Parameters:

2. Under the Script Detail column, select the item in the parameter box.

3. Right click the mouse button and an option box appears to the right of your
selection. This gives you the options that are available for the parameter
selected.

4. Select the desired option.
5. Keep the parameters in the same order as shown below:

«l PICkit Serial - 12C Master Mode
Communications  PICkit Serial Analvzer  Demo Boards  User Defined Templates  Wiew  Window — H
View: Advanced = Communications: Basic Operations | Reset | PICkit Serial Analvzer Mo, 1~
Script Builder
Example |2C Scripts Scrpt Detail User I2C Scripts
Script Mame A eaddddnss 1=l i i
MCPA725 \Wihite Wnitedddisg ||2CST'&'HT MCP4725_EE'Writg
- WwiiteBlockaddrad ||2E"-MF|TBYT MCP4725_Fead
a FeadB lockaddras |EIS - MCP4725_FRead_H
Save Script ‘ MCP4725B 0ard_
_ G -
Execute Script ‘ |EIF <
Clear Scrpt ‘ |FF x
1. Choose this box and right l2csTOP
Del User Ser cllc_k the mquse button for | x
J L B options available.
2. You can also change the | ®
Show Arra values or delete the boxes. || x
3. Make sure the listed | x
parameters in the “Script
Detail” should be in the | *
exact order as shown here. | x
| x
4. Change the parameter value.
Script Detail
I2CSTART *
I2CWRTBYT | *
03 | - > This means there are three bytes to send
co | > 1st Write Byte: Address byte = 1100-0000
OF | s > 2nd Write Byte: 0000-1111
FF | e > 3rd Write Byte: 1111-1111
1I2CSTOP *

Note: All 7 parameters above must be listed in order. The parameters with * are
not modifyable. Address bits A2, A1, A0 =1, 1, 0 if both IMP2 and JMP3
are tied to Vpp. You can choose any data you want for the 2nd and 3rd write

bytes. If you use the above write data, the MCP4725 device will output:
v _ VDD -FFF(hex)(V) _y
ouT 4096 DD

V)

DS51722A-page 20
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1Ml P|Ckit Serial - 12C Master Mode

Communications  PICkit Serial Analvzer  Demo Boards  User Defined Templates  Wiew  Window  Hs

‘iew: Advanced | Communications: Basic Operakions | Reset | PICKE Serial fnalyzer Mo, 1 -

Script Builder !

Example |2C Scripts Script Detail zer 12C Scrpts
Script Mame Readaddss el J
MCP4725 ‘Wiite Writedddnd 8 ||2E5T'&HT MCP4725_EEMritey
= riteBlockAddia g |I2EWFETBYT MCP4725_Read
i ReadBlockAddiAs |EI3 < MCP4725_Read E
Save Script @ T )_» | MCP4725B0ard
st Write Byte co x .
Execute Script | W(znd Write Byte)
Clear Script |

|FF x
’W\(&d Write Byte)

Del User Scripts |

4

Show Amray |

| X

ol [~

1.4.2.2  SAVING THE SCRIPT FILE AND PROGRAMMING DAC REGISTER
(FAST MODE)

1. Change 2nd and 3rd data bytes you want in the Script Detail.

2. Type in any script name (i.e., MCP4725_Write) in the space below the Script
Name menu.

3. Click Save Script button.
4. Click Execute Script button.

Note: Atthis point, the PICkit™ Serial transmits the Fast Write Command to the
MCP4725 device. The saved file name will appear in Users 12C Scripts
column and can be reused any time by selecting the file name.

5. The device provides analog output voltage (Voyt) at the Vgt terminal on the
MCP4725 PICtail™ Plus Daughter Board.

6. Vout can be monitored by using a voltmeter.

Note: When you click on the “Execute Script” menu, the “Busy” LED on the PICKkit
Serial Analyzer will momentarily turn on and then turn off. If the LED
remains ON, a communications problem has occurred. Remove the PICkit
Serial Analyzer from the personal computer and recheck the parameter
value in the order of the parameters under the Script Detail column. Try
again until the “Busy” LED goes OFF after executing the write command.

© 2008 Microchip Technology Inc. DS51722A-page 21
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1.4.2.3 CREATING SCRIPT FILE TO PROGRAM DAC REGISTER AND
EEPROM

1. Get a new script file by selecting the WriteAddrA8 from the “Example 12C
Scripts” column.
2. Modify the Script Detail column as shown below:

Script Detail

I2CSTART

I2CWRTBYT

04 | > This means Master will send four bytes

[ R — > 1st Write Byte: Address byte = 1100-0000
60 | s > 2nd Write Byte: 0110-0000

80 | e > 3rd Write Byte: 1000-0000

00 | e > 4th Write Byte: 0000-0000

1I2CSTOP

Vpp -Dn .
Now the device will output V7 = 04%96 =V iggéhex) = 25V

3. Type in the script name (i.e., MCP4725_ EEWrite) in the space below the Script
Name menu.
4. Click the Execute Script button.

adl PICkit Serial - 12C Master Mode

Communications  PICkit Serial Analvzer  Demo Boards  User Defined Templates  Wiew  Window  Help

Viewn: Basic | Communicakions: Basic Cperations | Reset

HELD

Example |2C Scripts Script Detail Jzer [2C Scripts

Script Mame HegdﬁddrAS [2CSTART
MCP4725_EEwiite wiiteAddiAS
WwriteBlockaddras 20w RTEYT

FeadBlockaddiad

MCP4725 Swfrite

MLCP4725 EEWite
MCP4725_Read
MCP4725_Read EE
MCP47258 nard W

4 Bytes to Send

Sawe Script

Clear Script -
2nd Write Byte

Del User Scripts | ((3rd Write Byte

4th Write Byte

Show Array |

1d Transactions

File = Edit = Clear
La_JLF—1

4:54:29 PM Sant script from Script Builder page, 11
bytes:
[s_1MW_1[04][col[e0][eo][@0] [P_]

f=_1rr1]

4:54:29 PM Sant script from Script Builder page, 11
bytes:

(-1 [w_J[o4] [Col[eo][eo] [20][P_]
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1.4.3 Verifying the EEPROM Data

One of the important features of the MCP4725 device is non-volatile memory. When
the device is first powered up, it outputs an analog voltage corresponding to the data
in the EEPROM. The user can confirm this feature using the following procedures:

1. Program the EEPROM memory. Refer to Section 1.4.2.2 “Saving the Script
File and Programming DAC Register (Fast Mode)”.

2. Remove power (Vpp) from the MCP4725 PICtail™ Plus Daughter Board, or
remove the daughter board from the Explorer 16 Development Board.

3. Connect power (Vpp) to the MCP4725 device.
4. You can confirm the Vg1 voltage by using a digital multimeter.

144 Reading the DAC Register Data using the PICkit™ Serial
Analyzer

You can read back the DAC code stored in the DAC register with the following steps:
1. Create aread command script file name as shown below and execute it.
2. The results (DAC code) will appear on the PICkit™ Serial Transactions page.

Communications  PICkit Serial Analyzer  Demo Boards  User Defined Templates  Wiew  Window — Help

View: Basic | Communications: Basic Operations | Reset

Script Builder !.

Example [2C Scriptz Script Detail |dzer [2C Scriptz
Script Name Feadtddrdd ’— - MCPA725 wirite
MCP4725 Read ket ddras SIS MCP4725 EEWrite
- wiriteBlockAddras I20WRTEYT MCP4725 Read
i ReadBlockAddias o - MCP4725 Read EE
Save Script MCP4725B nard_w

C1 x

Clear Script 3 x
12C5TOP

Del User Scripts x
x
Show Amay 3 Bytes ’—x
=
=
x
= -

e

File = Edit = Clear

6:30:40 PM sent script from Script Builder page, 10

bytes: .
Written Dat

using a Write C

[s_1wW_Jre3]rcolfos]oolr_]
[5_1[P_]
Script 'MCP4725_FRead' successtully updated.

G:32:21 PM sent script from Script Builder page, 10
bytes:

Reading Dat
[5_1 W ] [01][C1][RNI[@3][P_] using a Read Co
[s_]Cco][s0] [00] [P_]

© 2008 Microchip Technology Inc. DS51722A-page 23
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1441 READING BOTH THE DAC REGISTER AND EEPROM DATA:

The following script file can read both DAC input register and EEPROM.
1. Modify the script file as shown below and save it. Click on Execute Script button.

2. The results (DAC code and EEPROM data) will appear on the PICkit™ Serial
Transactions page.

Communications  PICkit Serial Analyzer  Demo Boards  User Defined Templates  Wiew  Windo

View: Basic = Comrunications: Basic Operations | Reset

Script Builder

Exarnple 12C Scripts Seript Detail Jzer [2C 5
Script M ame Readtddras 1=l MCP4725
MCP4725_Read EE |~ WiteAddiad /205 TART MCP4725_
=S WiteBlocksdding |20WRTEYT MCP4725
. ReadBlockadditd |EI'| - MCP4725
Save Script | MCP47258
- [ x
| Execute Script | |I2EF|DE=YTNLEI
Clear Scnpt | |5 x
|12C5TOP

Del User Scripts |

Requesting
5 Bytes

Show Amray |

ol|[ |
i

File = Edit = Clear

Written Data
using a Write Comman

G:41:13 PM Zent script from
bytes:

[s_1[0w_][o4][co][s0][80] [00][P_]
<: DAC :>
[s_1[P-1] egister Data <EEPROMDam )

G:dl:27 FM Se cript Builder page, 10
bytes:

1pt Builder page, 11

[=_J0w_J[01] Reading Data
using a Read Comman
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1.5 EXAMPLES OF THE MCP4725 PROGRAMMING USING THE PICKIT™
SERIAL ANALYZER

1 1 0 0 A2 | A1 | A0 | RW
Device Code Address Byte

* Address Byte: A2 = Al = 0 for Default Samples
A0 =0 if AO pin is Grounded
=1if AO pin is tied to Vdd

Example:

Write Mode: 0XCO for (A2 = A1 = A0)
0XC2 for (A2 = A1 = 0, AO = Tied to Vpp)

Read Mode: 0XC1 for (A2 = A1 = AO)
0XC3 for (A2 = Al =0, AO = Tied to Vpp)

FIGURE 1-9: MCP4725 Device Address Bytes.
Vv xDn 11
DAC Output = ~REF =3Vx2 _ 55y
4096 4096

Start | 0xCO 0|0|PD1|PDO|D11 |D10| D9 |D8 D8/ D7|D6|D5|D4 |D3| D2 | D1 DOl STOP

Address Byte:

when A2=A1=A0=0 OUO

=2t

FIGURE 1-10: Fast Mode Write Command for Vgt = 2.5V when Vggg = 5V.
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Vieg xDn _ 5V Xgll

DAC Output = = 2.5V
4096 4096
Start OxCO. ol1|l 1 | x| x| PD1|PDO| x D11|D10| D9| D8|D7 | D6 | D5 D4l
When A2=A1=A0=0 0x60 ox08 = 211

D3

D2

D1

DO

X | X

] B

~_

0x00

FIGURE 1-11:

Write Command for EEPROM and DAC Register for Vout = Vpp/2.

DS51722A-page 26
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Appendix A. Schematic and Layouts

A.1 INTRODUCTION
This appendix contains the following schematics and layouts for the MCP4725
PICtail™ Plus Daughter Board:
» Board — Schematic
» Board — Top Layer
« Board — Top Metal Layer
« Board — Bottom Layer

© 2008 Microchip Technology Inc. DS51722A-page 27
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BOARD - SCHEMATIC
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A.3 BOARD -TOP LAYER

i
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A.4 BOARD - TOP METAL LAYER

SDA1 VSS SCL1 VSS Vout

I VoD -

MCP4725
@® P15 il Plus

49 Daughter Board

s
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|
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A5 BOARD-BOTTOM LAYER

VR

e
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A.6 BOARD-BOTTOM METAL LAYER

0
Q

-
-

OO0

104—00186—R2
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MICROCHIP

Appendix B. Bill Of Materials (BOM)

TABLE B-1: BILL OF MATERIALS (BOM)
Qty Reference Description Manufacturer Part Number
C1 CAP .1UF 16V CERAMIC X7R 0603 |Panasonic - ECG ECJ-1VB1C104K
Cc2 CAP 1.0UF 16V CERAMIC X5R 0603 | Panasonic - ECG ECJ-1VB1C105K
J2 DO NOT POPULATE Molex/Waldom Electronics | 22-28-4060
CONN HEADER 6POS .100 VERT Corp
TIN
1 JMP1 CONN HEADER 3POS .100" STR Molex/Waldom Electronics | 90120-0123
TIN Corp
3 JMP1, JP1, SHUNT LP W/HANDLE 2 POS 30AU | Tyco Electronics/Amp 881545-2
JP2 Bag shunts with kit
2 JP1, JP2 CONN HEADER 2POS .100 VERT Molex/Waldom Electronics | 22-03-2021
TIN
1 PCB RoHS Compliant Bare PCB, — 104-00186
MCP4725 PICtail Plus Daughter
Board
1 R1 RES 100 OHM 1/10W 1% 0603 SMD | Panasonic - ECG ERJ-3EKF1000V
R2, R3 RES 10.0K OHM 1/10W 1% 0603 Panasonic - ECG ERJ-3EKF1002V
SMD
R4, R5, R6, R7 |RES 0.0 OHM 1/10W 5% 0603 SMD | Yageo Corporation RC0603JR-070RL
1 SP1 BUZZER PIEZO 3KHZ 24MM PC MT | Mallory Sonalert Products | PK-21N30PQ
Inc
5 TP1, TP2, T3 |PC TEST POINT COMPACT SMT Keystone Electronics 5016
TP4, TP5
1 Ul 12-Bit Digital-to-Analog Converter Microchip Technology Inc | MCP4725A0T-E/CH
with EEPROM Memory in SOT-23-6
1 VR1 POT 5.0K OHM THUMBWHEEL Bourns Inc. 3352T-1-502
CERM ST
Note 1. The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM

used in manufacturing uses all RoHS-compliant components.
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Tel: 774-760-0087
Fax: 774-760-0088
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Tel: 630-285-0071
Fax: 630-285-0075

Dallas

Addison, TX

Tel: 972-818-7423
Fax: 972-818-2924
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Farmington Hills, Ml
Tel: 248-538-2250
Fax: 248-538-2260

Kokomo

Kokomo, IN

Tel: 765-864-8360
Fax: 765-864-8387

Los Angeles
Mission Viejo, CA
Tel: 949-462-9523
Fax: 949-462-9608

Santa Clara

Santa Clara, CA
Tel: 408-961-6444
Fax: 408-961-6445

Toronto
Mississauga, Ontario,
Canada

Tel: 905-673-0699
Fax: 905-673-6509

ASIA/PACIFIC

Asia Pacific Office
Suites 3707-14, 37th Floor
Tower 6, The Gateway
Harbour City, Kowloon
Hong Kong

Tel: 852-2401-1200
Fax: 852-2401-3431
Australia - Sydney
Tel: 61-2-9868-6733
Fax: 61-2-9868-6755
China - Beijing

Tel: 86-10-8528-2100
Fax: 86-10-8528-2104

China - Chengdu
Tel: 86-28-8665-5511
Fax: 86-28-8665-7889

China - Hong Kong SAR
Tel: 852-2401-1200

Fax: 852-2401-3431
China - Nanjing

Tel: 86-25-8473-2460
Fax: 86-25-8473-2470
China - Qingdao

Tel: 86-532-8502-7355
Fax: 86-532-8502-7205

China - Shanghai
Tel: 86-21-5407-5533
Fax: 86-21-5407-5066

China - Shenyang
Tel: 86-24-2334-2829
Fax: 86-24-2334-2393

China - Shenzhen
Tel: 86-755-8203-2660
Fax: 86-755-8203-1760

China - Wuhan
Tel: 86-27-5980-5300
Fax: 86-27-5980-5118

China - Xiamen

Tel: 86-592-2388138
Fax: 86-592-2388130
China - Xian

Tel: 86-29-8833-7252
Fax: 86-29-8833-7256

China - Zhuhai
Tel: 86-756-3210040
Fax: 86-756-3210049

ASIA/PACIFIC

India - Bangalore
Tel: 91-80-4182-8400
Fax: 91-80-4182-8422

India - New Delhi
Tel: 91-11-4160-8631
Fax: 91-11-4160-8632

India - Pune
Tel: 91-20-2566-1512
Fax: 91-20-2566-1513

Japan - Yokohama
Tel: 81-45-471- 6166
Fax: 81-45-471-6122

Korea - Daegu
Tel: 82-53-744-4301
Fax: 82-53-744-4302

Korea - Seoul

Tel: 82-2-554-7200
Fax: 82-2-558-5932 or
82-2-558-5934

Malaysia - Kuala Lumpur
Tel: 60-3-6201-9857
Fax: 60-3-6201-9859

Malaysia - Penang
Tel: 60-4-227-8870
Fax: 60-4-227-4068
Philippines - Manila
Tel: 63-2-634-9065
Fax: 63-2-634-9069
Singapore

Tel: 65-6334-8870
Fax: 65-6334-8850

Taiwan - Hsin Chu
Tel: 886-3-572-9526
Fax: 886-3-572-6459
Taiwan - Kaohsiung
Tel: 886-7-536-4818
Fax: 886-7-536-4803
Taiwan - Taipei

Tel: 886-2-2500-6610
Fax: 886-2-2508-0102

Thailand - Bangkok
Tel: 66-2-694-1351
Fax: 66-2-694-1350

EUROPE

Austria - Wels

Tel: 43-7242-2244-39
Fax: 43-7242-2244-393
Denmark - Copenhagen
Tel: 45-4450-2828

Fax: 45-4485-2829

France - Paris

Tel: 33-1-69-53-63-20
Fax: 33-1-69-30-90-79
Germany - Munich
Tel: 49-89-627-144-0
Fax: 49-89-627-144-44
Italy - Milan

Tel: 39-0331-742611
Fax: 39-0331-466781

Netherlands - Drunen
Tel: 31-416-690399
Fax: 31-416-690340
Spain - Madrid

Tel: 34-91-708-08-90
Fax: 34-91-708-08-91
UK - Wokingham

Tel: 44-118-921-5869
Fax: 44-118-921-5820
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